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Author Questionnaire 
1. We have marked your project as author-provided footage, meaning you film the video yourself and provide JoVE with the footage to edit. JoVE will not send the videographer. Please confirm that this is correct. 
√ Correct 
☐ Incorrect 

 2. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Yes  
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
4.1

3. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Yes
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k

As these files are necessary for finalizing your script, please upload all screen captured video files to your project page as soon as possible.

4. Proposed filming date: To help JoVE process and publish your video in a timely manner, please indicate the proposed date that your group will film here: 10/06/2025

DO NOT use this draft script for filming. Please wait until your script is finalized to begin the filming process. 

When you are ready to submit your video files, please contact our Content Manager, Utkarsh Khare.
To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length

Number of Steps:  18
Number of Shots:  30  (9 SC)

Introduction 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up to 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Answer in full sentences, in a style suitable for being spoken aloud.
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Khairiah Razali: This research focuses on developing a reliable, simple, and cost-effective method to assess blood-brain barrier integrity in adult zebrafish.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What research gap are you addressing with your protocol?
1.6. Khairiah Razali: Most zebrafish studies don’t have an easy, reliable way to measure blood-brain barrier disruption, and existing methods are often complex or costly. This protocol offers a practical, affordable solution.

What advantage does your protocol offer compared to other techniques?
1.7. Khairiah Razali: This protocol is simple, cost-effective, and combines both visual and measurable analysis—all without the need for expensive equipment or complicated steps.
How will your findings advance research in your field?
1.8. Khairiah Razali: By providing a simple, reproducible protocol, it will make it easier for labs to explore neurovascular changes in adult zebrafish disease models.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What research questions will your laboratory focus on in the future?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.



Ethics Title Card
This research has been approved by the Institutional Animal Care and Use Committee (IACUC) under the International Islamic University Malaysia (IIUM)


Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that you/your videographer will capture. 

2. Administering Evan’s Blue Dye to Adult Zebrafish and Stab Wound Injury (SWI) Induction
Demonstrator: Khairiah Razali


2.1. To begin, anaesthetize the zebrafish by gradually lowering the water temperature from 12 degrees Celsius to 7 degrees Celsius until the fish no longer responds to tactile stimuli [1].
2.1.1. WIDE: Talent lowering the temperature of the water tank. Authors: We do not have to show the fish being anesthetized in this step. Just show the temperature adjustment.

2.2. Using a 31-gauge insulin syringe, inject 20 microliters of 1 percent Evan’s blue or EB dye into the intraperitoneal cavity of the fish [1] and apply gentle pressure at the injection site for 10 seconds to prevent backflow [2].
2.2.1. Talent injecting Evan’s blue dye into the intraperitoneal cavity of the fish using a fine insulin syringe.
2.2.2. Talent applying gentle pressure with a gloved finger to the injection site.

2.3. Now, transfer the fish to a recovery tank [1] and allow recovery for 30 minutes [2]. Monitor the fish for injury, mortality, or behavioral changes during this time [3].
2.3.1. Talent moving the fish carefully into a clean recovery tank.
2.3.2. Shot of the fish swimming in the recovery tank.
2.3.3. Talent pointing to a fish closely and noting something in a book. TXT: Euthanise the fish after 30 min (Hypothermic shock at 1 - 3 °C); Skip to brain dissection if required

2.4. For establishing a positive control, prepare a sterile 31-gauge needle attached to an insulin syringe to perform a stab wound injury procedure [1].	Comment by Poornima  G: Authors, this section is moved ahead to maintain a good flow in the video
2.4.1. Talent preparing a sterile needle and syringe on a sterile surface.

2.5. After a 30-minute recovery period, anaesthetize the fish again as demonstrated earlier [1].
2.5.1. Talent picking up an anesthetized fish from the container.

2.6. Position the fish upright on a flat cold surface, such as an ice gel pack [1]. Insert the needle into one side of the telencephalon at a 90-degree angle to a depth not exceeding 1.5 millimeters [2].
2.6.1. Talent positioning the fish upright on an ice gel pack.
2.6.2. Shot of inserting the needle at a right angle into the telencephalon with careful precision.

2.7. Then, transfer the fish to a recovery tank and let it recover for 30 minutes [1].
2.7.1. Talent moving the fish gently into a recovery tank.



3. Fixation and Dissection of the Zebrafish Brain 
Demonstrator: Khairiah Razali

3.1. After euthanizing the fish by hypothermia, use a sterile blade or surgical scissors to decapitate the euthanized fish [1].
3.1.1. Talent decapitating the fish using sterile surgical scissors or blade.

3.2. Rinse the head twice in 1x PBS, using a 1 to 20 ratio of fish to PBS, to remove excess blood and Evan’s blue dye [1].
3.2.1. Talent rinsing the decapitated fish head in a beaker containing PBS.

3.3. Then, fix the head in 4 percent paraformaldehyde using a 1 to 20 ratio of fish to fixative [1] and incubate at 4 degrees Celsius overnight [2].
3.3.1. Talent placing the head sample into a container filled with paraformaldehyde solution.
3.3.2. Talent placing the PFA container with fish in a refrigerator

3.4. Place the fixed head in a clean petri dish [1] and dissect the brain using pointed-end tweezers [2]. Continuously add PBS dropwise during dissection to keep the tissue hydrated and prevent drying [3].
3.4.1. Talent positioning the fixed head in a petri dish.
3.4.2. Talent carefully beginning brain dissection with tweezers.
3.4.3. Talent adding drops of PBS with a pipette while continuing the dissection.

3.5. Rinse the dissected brain twice in two separate PBS baths [1] and place the tissue on a 1 percent agarose plate to retain moisture and prevent shrinkage [2].
3.5.1. Talent dipping the dissected brain in one PBS bath beside which another bath is kept.
3.5.2. Talent transferring the brain onto a moist agarose plate.



4. Quantitative Analysis of Evan’s Blue (EB) Extravasation
Demonstrator: Khairiah Razali

4.1. Observe the dissected brain tissues under a stereomicroscope [1].
4.1.1. Talent placing the sample under a stereomicroscope.

4.2. To begin quantitative analysis, download and install Fiji software [1] and open the brain image file in Fiji [2].
4.2.1. SCREEN: Show the Fiji website download page with the download button being clicked.
4.2.2. SCREEN: Show Fiji software window with the brain image file opened.
[bookmark: _Hlk162020732][bookmark: _Hlk203170338]Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible : https://review.jove.com/account/file-uploader?src=21048098 

4.3. Perform colour deconvolution by selecting Image followed by ColourColor, Colour Deconvolution and choose RGB [1]. This will result in three separate images representing red, green, and blue hues [2].	Comment by Poornima  G: Authors, this point the spelling is “Colour” and in the next one it is “Color”. Can you please indicate which one appears in the software?	Comment by KHAIRIAH BINTI RAZALI: In the software, “Color” is spelled that way, while “Colour” appears specifically in “Colour Deconvolution.” Additionally, the channel image is labeled as “Colour.”
4.3.1. SCREEN: Show the Fiji menu navigation to Image > Colour Color > Colour Deconvolution > RGB.
4.3.2. SCREEN: Show the output of three separate hue images.

4.4. Now, activate the blue channel image, usually labelled "Color_3Colour_3" (color-3), by clicking on the image [1]. Convert it to 8-bit grayscale by selecting Image followed by Type and 8-bit [2].
4.4.1. SCREEN: Highlight the selection of the blue channel image "Color_3Colour_3".
4.4.2. SCREEN: Show Fiji menu navigation to Image > Type > 8-bit, followed by the converted grayscale image.

4.5. Next, to mMeasure the grey intensity of the 8-bit image, set the measurement parameters by selecting Analyse and Set Measurements [1]. Then, choose the Area and Mean grey value [2]. 
4.5.1. SCREEN: Show Fiji window with the Analyse and Set Measurements being selected.
4.5.2. SCREEN: Area and Mean grey value being chosen.

4.6. Using the rectangle selection tool, draw a uniform-sized region of interest [1] and measure the grey intensity by selecting Analyze followed by Measure [2], or pressing Ctrl and M key.
4.6.1. SCREEN: Show the rectangle tool being selected and an ROI being drawn, followed by the navigation to Analyze > Measure.
4.6.2. SCREEN: Show the output of the measurement.
4.6.3. SCREEN: Show Fiji tool panel with the grey intensity measurement being executed on the grayscale image.

4.7. Finally, set the measurement parameters by selecting Analyse and Set Measurements [1]. Then, choose the Area and Mean grey value [2]. 
4.7.1. SCREEN: Show Fiji window with the Analyse and Set Measurements being selected.
4.7.2. SCREEN: Area and Mean grey value being chosen.




Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 200.
· Please note that the video cannot include voiceover without an accompanying visual.

5. Results 

5.1. Normal zebrafish displayed a typical brownish skin tone [1], and the EB-injected zebrafish exhibited a noticeable bluish hue [2].
5.1.1. LAB MEDIA: Figure 1A
5.1.2. LAB MEDIA: Figure 1B

5.2. To investigate blood-brain barrier integrity in the adult zebrafish Parkinsonian model, EB dye extravasation into brain tissues was compared between saline-injected control and Parkinsonian zebrafish [1]. In the negative control group, blood vessels in the brain appeared reddish, indicating the absence of EB dye extravasation [2].
5.2.1. LAB MEDIA: Figure 3. 
5.2.2. LAB MEDIA: Figure 3.  Video editor: Highlight A

5.3. In contrast, the saline-injected control [1], positive control [1], and Parkinsonian groups [3] all showed bluish coloration in brain vasculature, confirming successful systemic circulation of EB dye [3].
5.3.1. LAB MEDIA: Figure 3. Video editor: Highlight C.
5.3.2. LAB MEDIA: Figure 3. Video editor: Highlight B.
5.3.3. LAB MEDIA: Figure 3. Video editor: Highlight D.
5.3.4. LAB MEDIA: Figure 3 Video editor: Highlight B, C, D.

5.4. Dissected brains from the negative control group appeared whitish with clearly visible reddish blood vessels, confirming the absence of EB staining [1].
5.4.1. LAB MEDIA: Figure 4A. Video editor: Highlight the whitish brain tissue and reddish blood vessels.

5.5. In the positive control injury group, intense blue coloration surrounding the brain tissue indicated dye leakage due to deliberate blood-brain barrier disruption [1].
5.5.1. LAB MEDIA: Figure 4B. 

5.6. In the saline-injected group, EB staining remained confined to the blood vessels, indicating an intact blood-brain barrier [1].
5.6.1. LAB MEDIA: Figure 4C. Video editor: Highlight the blood vessels with blue staining.

5.7. The Parkinsonian group showed a darker, more diffuse blue staining pattern, indicating significant EB dye leakage and blood-brain barrier compromise [1].
5.7.1. LAB MEDIA: Figure 4D. 

5.8. Quantitative grayscale analysis revealed significantly lower grey intensity values in the Parkinsonian group [1] compared to the saline-injected group [2].
5.8.1. LAB MEDIA: Figure 5. Video editor: Highlight the lower blue bar for the Parkinsonian group
5.8.2. LAB MEDIA: Figure 5. Video editor: Highlight the white blue bar for the saline-injected group
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